Microsoft Office Access 2013
Relational Databases and Subforms
Table of Contents

Introduction.............................................................................................................................................. 4
Objectives .................................................................................................................................................. 4
Relationships and Tables .......................................................................................................................... 5
Using Multiple Tables in the Access Database ....................................................................................... 5
Relationships Explained ........................................................................................................................... 5
Relationships and Data Types .................................................................................................................. 6
How to Create the Relationship .............................................................................................................. 7
Relationships and Forms .......................................................................................................................... 9
Creating a Form for a Two Table Relationship ...................................................................................... 9
Creating a Form with Tabs for a Multi-Table Relationship ................................................................. 14
Additional Assistance .............................................................................................................................. 19
Introduction

Microsoft Access allows people to effectively and efficiently organize data. This document has been developed to show you how to use multiple tables and relational databases in Access 2013. The various sections presented in this document will help you to build a solid knowledge foundation of the software.

The Microsoft Access Booklet Series will provide you the necessary knowledge on how to use Microsoft Office Access 2013. Before reading this booklet, it is recommended that you read the following Access 2013 documents on the UITS Documentation Center at [http://uits.kennesaw.edu/cdoc](http://uits.kennesaw.edu/cdoc):

1. Microsoft Office Access – Intro to Access 2013
2. Microsoft Office Access - Forms

Objectives

The following objectives are covered in this document:

- Understanding the concept of relationships as they relate to tables.
- Knowing how to define data types for relationships.
- Having the ability to create a relationship.
- Understanding relationships and forms.
- Knowing how to create a form for a two table relationship.
- Knowing how to create a tab form for a multi-table relationship.
Relationships and Tables

The power of Access is the software’s ability to create and maintain multiple tables. Access allows multiple tables to work together thereby giving you strong database management capabilities.

Using Multiple Tables in the Access Database

Users of Access begin to utilize the full strength of the system when they use multiple tables to manage data. For example, the following are two tables that could be used by a retail store that sells products to customers (see Figure 1).

<table>
<thead>
<tr>
<th>Customer Information</th>
<th>Purchases</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Number</td>
<td>Purchase ID</td>
</tr>
<tr>
<td>First Name</td>
<td>Customer Number</td>
</tr>
<tr>
<td>Last Name</td>
<td>Product Name</td>
</tr>
<tr>
<td>Address</td>
<td>Quantity</td>
</tr>
<tr>
<td>City</td>
<td>Unit Price</td>
</tr>
<tr>
<td>State</td>
<td></td>
</tr>
<tr>
<td>Zip Code</td>
<td></td>
</tr>
<tr>
<td>Phone Number</td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td></td>
</tr>
</tbody>
</table>

Figure 1 - Two Tables

It would be ineffective to attempt to include all of the fields presented in Figure 1 in one table. It is much more efficient to create two tables and categorize the various fields within these tables.

An effective database used by a business, educational facility, governmental agency, etc. would ultimately have many tables.

Relationships Explained

When developing a database with multiple tables, it is important to understand relationships. Relationships allow the different tables to communicate with each other. When creating different tables, there must be one field that is common to the different tables. For example, Figure 2 shows that the Customer Number field is common to both tables.
Relationships and Data Types

When developing multiple tables, the *Data Type* for the common field will be defined differently in the various tables.

For example, the figure below shows that the *Data Type* for *Customer Number* is defined as *AutoNumber* in the *Customer Information* table because this table is where the number is created. Notice that this number is also the *Primary Key* (see Figure 3).

In the *Purchases* table, *the Customer ID* is defined as a *Number*. Also, notice that it is not defined as the *Primary Key* (see Figure 4).
How to Create the Relationship

The following explains how to create a relationship between two tables in Access.

1. Be sure to close both tables.
2. From the *Database Tools* tab, click *Relationships* (see Figure 5).

![Figure 5 - Relationships](image)

3. In the *Show Table* dialogue box, select each table and click **Add** (see Figure 6).

![Figure 6 - Click Add](image)

4. Both of the tables will be added to the *Relationships* window. Next, click the **Close** button in the *Show Table* dialogue box (see Figure 7).

![Figure 7 - Click Close](image)
5. Click to select **Customer Number** in the *Customer Information* table (see Figure 8).

![Figure 8 - Customer Number](image)

6. Hover your mouse over **Customer Number** in the *Customer Information* table and left-click your mouse. Drag over the **Customer Number** in the *Purchases* table and release (see Figure 9).

![Figure 9 - Creating the Relationship](image)

7. The *Edit Relationships* dialogue box will appear. Click to select the box for **Enforce Referential Integrity** and click the **Create** button (see Figure 10).

![Figure 10 - Enforce Referential Integrity](image)
What happens when you enforce referential integrity?

1. If the record doesn’t exist in the primary key field of the primary table, it can’t be entered in another related table.

2. The record can’t be deleted from the primary table if there is a record that relates in another related table.

3. The primary key number cannot be changed in the primary table if there is a record that relates to it in another related table.

8. The relationship will be established (see Figure 11).

![Figure 11 - The Relationship is established](image11)

9. Click the Close button to exit the Relationship Tools screen. When prompted, click Yes to save the relationship that you created (see Figure 12).

![Figure 12 - Close Button](image12)

Relationships and Forms

There are many different ways to develop forms when you have relationships among different tables established. The following are some popular design techniques.

Creating a Form for a Two Table Relationship

The following is an example of how to develop a form for a two table relationship. For example, you may need multiple table forms in the event you have a database that contains...
more than one table. The tables within the database are *Customer Information* and *Purchases* (see Figure 13).

![Figure 13 - Tables to create the form](image)

1. Create a form for the *Customer Information* table (see Figure 14).

![Figure 14 - Form for Customer Information Table](image)

Note: For more information on creating *Forms*, refer to the documentation *Microsoft Office Access 2013: Forms* at [https://uits.kennesaw.edu/cdoc](https://uits.kennesaw.edu/cdoc).

2. On the *Design* tab, click the *More* button for additional controls (see Figure 15).

![Figure 15 - The More Button](image)
3. Click the **Subform/Subreport** button (see Figure 16).

**Figure 16 - Subform/Subreport**

4. Draw a **box** on the form for the *Purchases* table (see Figure 17).

**Figure 17 - Purchases Table Form**

5. In the **Subform** Wizard, click **Next** (see Figure 18).

**Figure 18 - Click Next**
6. Click to **select the table** that you want to place on the form (see Figure 19).

   ![Figure 19 - Subform Wizard](image)

7. Click the **double-arrow** button to add all of the fields onto the subform that you are creating (see Figure 20).

   ![Figure 20 - Sub form Arrow](image)

8. Click the **Finish** button (see Figure 21).

   ![Figure 21 - Click Finish](image)
9. The *Purchases* subform will appear on the *Customer Information* form (see Figure 22).

![Figure 22 – Subform](image)

10. You may now enter data in both the form and subform (see Figure 23).

![Figure 23 - Entering Data](image)
Creating a Form with Tabs for a Multi-Table Relationship

The following explains how to create a form with tabs for a multi-table relationship. Forms with tabs are necessary in the event that you need to enter data into a database with multiple tables.

1. Create the necessary tables for the database. In this example we will need tables for an insurance company database. Figure 24 illustrates a database that has tables for:
   - Customer Information
   - Auto insurance
   - Life insurance
   - Property insurance.

![Figure 24 - Tables for an Insurance Database](image)

2. Create a relationship for all of the tables in the database shows an example of relationships created for a database for an insurance company (see Figure 25).

![Figure 25 - Relationships for the Database](image)

3. Create forms for all of the tables EXCEPT for the main table. For example you would create forms for Auto, Property, and Life.
4. The following steps explain how to create the main form.

4.1. Apply any color/labels to your form.

4.2. On the Design tab, click the Tab Control button (see Figure 26).

![Figure 26 - Tab Control Button]

4.3. Draw the Tab onto the Form (see Figure 27).

![Figure 27 - Draw Tab on the form]

4.4. To add more tabs, right-click over one of the tabs and click **Insert Page**. To delete a tab, click **Delete Page** (see Figure 28).

![Figure 28 - Insert and Delete Page]
4.5. To rename the tab, click to **select the tab**. Then, open the *Property Sheet*. On the *Format* tab in the *Caption* category, enter the *name* of the tab (see Figure 29).

![Figure 29 - Renaming Tabs](image)

4.6. To add the fields onto the tab for this main form, click **Add Existing Fields** (see Figure 30).

![Figure 30 - Add Existing Fields](image)

4.7. In the *Field List* window that appears, click **Show all tables** (see Figure 31).

![Figure 31 - Show all Tables](image)

4.8. Click the “+” for the name of the main table containing the fields that you want to add. For this example, you would click the “+” for *Customer Info* (see Figure 32).

![Figure 32 - Expanding the Table](image)
4.9. Drag the **fields** onto the form for the tab that you have selected (see Figure 33).

![Figure 33 - Main Tab](image)

5. You are now ready to add the forms that you created earlier to the other tabs. Click to select the **tab** where you want to add your form (see Figure 34).

![Figure 34 - Select the Tab](image)
6. From the **Design** tab, click the **More** button (see Figure 35).

![Figure 35 - The More Button](image)

7. Select the **Subform/Subreport** Button (see Figure 37).

![Figure 36 - Subform/Subreport](image)

8. Draw a box on the form for the selected tab.

9. The **Subform Wizard** dialogue box will appear. Select the option, **Use an existing form** and then select the **form** of your choice (see Figure 37).

![Figure 37 - Subform Wizard](image)
10. Click the Finish button.
11. Use the anchor points around the form to adjust the size.
12. The Auto Form tab appears (see Figure 38).

![Figure 38 - Subforms](image)

13. Repeat steps 5 – 11 to add the remaining subforms on the Form.

**Additional Assistance**

*If you need additional assistance with Microsoft Office Access 2013, contact University Information Technology Services (UITS) at:*

**Faculty and Staff Service Desk**  
Phone: 470-578-6999  
Email: service@kennesaw.edu

**Students Help Desk**  
Phone: 470-578-3555  
Email: studenthelpdesk@kennesaw.edu